
BLENDER  2.5
GUIDE



Prefaction

Ceci est un guide pour qui veut commencer a user Blender.
Qu'est-ce  que  c'  est  Blender?  Blender  est  un  programme  pour  la  modèlisation  3d,  
concurrent des divers Maya, 3dstudioMax, AutoCad, etc....
C'est un programme open source, libre, utilizzable sur systèmes Unix, Mac e Windows.
Avec ce programme on peut realizzer des excellent travail de toutes sortes, comme un 
simple objet 3d, animation, un jeu, même un film entier.
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Fenêtre principale

On commence. Juste après avoir lancer le programme voilà ce qui apparaîtra en face de 
vous. Il s'agit de la fenêtre principale de Blender. Peu à peu, nous en venons à connaître 
la plupart des menus. D'abord, nous partons 
du  cube  dans  le  centre  qui  est  fait 
automatiquement,  avec  la  lampe  sur  la 
droite et à gauche l'appareil.
Pour comprendre un peu mieux »3d terme il 
suffit de placer le pointeur sur l'écran central 
et en maintenant pressé le bouton central de 
la souris déplacez-le légèrement
L'image va tourner et vous remarquerez que 
c'est  comme  le  monde  réel.  Vous  êtes 
vraiment  entrain  de  tourner  autour  d'un 
objet!.
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Plans fondamentaux

Comment puis-je changer shot? 
Rien ne pourrait être plus facile.
Pour le plan du haut,  du pavé 
numérique pressez le 7. Et voici 
le résultat:

Pour le plan frontal presser, toujours du clavier, le bouton1:
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Enfin pour le plan latéral presser la touche3:

Ces trois sont les plans de base, ceux que vous utiliserez toujours, pour tout travail. En 
appuyant d'autres numéros sur le clavier vous obtiendrez des autres plans.
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Ajoutez des objets

Pour sélectionner un element il suffit de cliquer dessus avec le 
bouton droit de la souris.  Quand un objet est sélectionné ses 
contours deviennent orange.  Sélectionnez maintenant le cube 
et  appuyez  sur  la  touche  x,  vous allez  voir  un  menu  et  en 
cliquant sur Delete seront supprimès les objets sélectionnés. 
Allez dans le menu  Add , puis  Mesh, vous verrez la liste des 
objets insérables.

Nous commençons par la première voix. En cliquant sur Plane sera inséré figure plane.
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Maintenant, essayez les autres articles:

Cube: pour inséré un cube;

Circle: pour ajouter un cercle (circonférence). Du point Vertices (côté 
gauche),  vous  pouvez  sélectionner  le  nombre  de  sommets  qui  le 
composent, tandis qu' avec Radius vous augmentez la taille du rayon. 
En sélectionnant Fill le cercle sera fermé.

UVSphere:  article  consacré  à  l'inclusion  d'une  sphère.   Avec 
Segments vous  changez  le  nombre  de  divisions  verticales, avec 
Rings les divisions orizzontales.

IcoSphere:  une  Icosphere  est  une  sphère  composée  de  faces 
triangulaires.

Tube: pour insérer un cylindre. 

Cone: pour insérer un cône.

Grid: voix pour insérer un plan subdivisé plusieurs foix , pratiquement une grille.

Monkey: fonction amusante pour ajouter la mascotte de Blender.

Torus: en sélectionnant cette voix nous aurons une circonférence fermé comme la gomme 
d'une moto, ou comme un savarin.
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Déplacer, Dégressif et Tourner

Bien,  maintenant  nous  repartons  de  la  blindée 
principale en sélectionnant File>New. 
Une fois le cube sélectionné, appuyez sur la touche G 
et déplacez la souris. Voilà que le cube se déplace.
Comme toujours, le bouton gauche pour confirmer et 
bouton droit pour annuler.
Si  vous  avez  confirmé  et  vous  voulez  revenir  en 
arrière et il suffit d'utiliser Ctrl-Z.
Comment déplacer un mesh le long d'un axe unique?

Déplacement un mesh le long de l'axe z:
Sélectionnez le cube et appuyez successivement G et Z, vous allez voir une ligne bleue, si 
vous bougez l'objet il va se déplacer seulement verticalement.

Déplacement d'un mesh le long de l'axe des x:
Vous sélectionnez le cube et vous pressez en succession G et X, dans ce cas une ligne 
rouge apparaîtra.

Déplacement d'un mesh le long de l'axe y:
Vous sélectionnez le cube et vous pressez en succession G et Y,  dans cet autre cas une 
ligne verte apparaîtra.
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Pour dégressif un objet le procédé est le même du déplacement mais dans ce cas au lieu 
de la touche G nous utiliserons la touche S.

Les combinaisons différentes seront ensuite:

S+Z pour dégressif le long de l'axe z;

S+X pour dégressif le long de l'axe x;

S+Y pour dégressif le long de l'axe y.

Même chose vaut pour la rotation, mais dans ce cas en utilisant la touche R, nous aurons 
donc:

R+Z: rotation selon l'axe z;

R+X: rotation selon l'axe x;

R+Y: rotation selon l'axe y.
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3d Manipulation Mode

En cliquant sur le bouton avec trois lignes colorées, le menu sera affiché. Allons l'analyser.

Lorsque elle est sélectionnée la flèche, apparaissent des flèches 
de trois couleurs. Bleu pour l'axe z (hauteur), Rouge pour l'  axe x 
(largeur), Vert pour l' axe y (profondeur).Si vous maintenez pressé 
le bouton gauche de la souris sur une des flèches et vous faites 
glisser l'objet li se déplace dans la direction de cette flèche. Par 
exemple si vous maintenez pressé le bouton gauche sur la flèche 
bleu et vous faites glisser l'objet il se dèplacera le long de l'axe z.

Tandis que si au lieu de la flèche vous selectionnez le bouton chi 
représente une courbe il apparaîtra la suivante figure.  
Dans ce  cas  si  vous sélectionnez une des lignes colorées et 
vous trainez l'objet il sera tourné le long de l' axe. 

Lorsque  à  être  sélectionné  il  est  la  flèche  avec  pointe  carrée 
réapparaîtront les flèches mais avec la partie finale carrée. Dans ce 
cas nous pouvons escalader l'objet.

En  voulant  les  valeurs  d'agrandissement,  le  déplacement  et  la  rotation   peuvent  être 
inséré du clavier. Par exemple si nous voulons tourner un objet de 45 degrés long l' axe z, 
nous ne devons pas faire autre que le sélectionner, presser R>Z et écrire 45.
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Object Mode – Edit Mode

En bas vous trouverez écrite Object Mode,

lorsque vous vous trouvez dans cette modalité un objet peut être modifié seulement dans 
le  sien  de  l'ensemble, ils  ne  peuvent  pas  être  modifié  les  individuels  sommets. 
Généralement on emploie la modalité Object Mode pour tourner, escalader ou déplacer un 
objet.  
Pour “modeller” un objet on doit entrer en modalité Edit Mode.
Si vous ouvrez le menu vous verrez qu'il y a des diverses modalités d' utilise. 
Pour l'instant, concentrons-nous sur ces deux.

Maintenant  sèlèctionnez  le  cube  pour  entrer  en  modalité  Edit  Mode vous  pressez  la 
touche Tab. Le cube apparaîtra avec le contour orange et les faces d'un marron clair et 
seront reconnaissable les sommets. 
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Sélectionnez un sommet, puis pressez la touche G et déplacez le sommet en déplacent la 
souris, touche gauche pour confirmer.
Ensuite pour tourner en modalité Object Mode toujours avec la touche Tab. Vous devriez 
obtenir un résultat semblable all'  image ici en bas.

Si vous retournez en Edit Mode (touche Tab), il sera sélectionné seulement le sommet que 
vous  avez  utilizzé  d'abord.  Pour  sélectionner  ou  désélectionner  tous  les  sommets 
rapidement il suffit d'employer la touche. Si maintenant vous le pressez il désélectionnera 
tout, si vous le pressez un' autre fois vous aurez tous les sommets sélectionnés. 
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Et si nous ne sélectionnons que les sommets au centre?

Aller dans  le cadre du haut (touche 7) et désactivez les sommets (touche A).
 

Maintenant  si  vous  appuyer  sur  le  bouton  B  autour  du  pointeur  ils  apparaitront  des 
prolongements.  Maintenant, maintenez enfoncé le bouton gauche de la souris, tracez un 
carré autour du sommet central comme dans la figure ci-dessous.

Maintenant, si vous laissez le bouton gauche 
de la souris, vous sélectionnez les sommets à 
l'intérieur de la zone choisie.

Si  vous  essayez  de  faire  la  même action  d'avant  en  activant  ce  bouton  vous 
pourrez voir que seul les sommets plus élevés seront choisis, car ce bouton rend 
invisible les sommets qui sont derrière.
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Diviser et ajouter des sommets

Maintenant nous commençons un nouveau travail (File>New),
supprimons le cube (X>Delete)  et ajoutons un plan (Add>Mesh>Plane).  Pour  pouvoir 
rendre invisibles  les figures et pour voir bien les sommets nous utilisons la fonction Wireframe.

Maintenant  notre  plan  est  formé  par  quatre  sommets.  Voyons  comment  en  ajouter 
d'autres. Avec tous les sommets sélectionnés en appuyant sur le bouton W, dans le menu 
qui apparaît, vous devez sélectionner Subdivide.Le plan a maintenant 9 sommets. Si vous 
répétez l'action de nouveau il y en aura 25.

13



Maintenant nous analysons deux autres 
manières pour ajouter des sommets.

Nous revenons à notre plan de base, (4 sommets), avec Ctrl+Z.
Toujours en Edit Mode nous appuyons en succession Ctrl+R et nous remuons la souris à 
l'intérieur du plan, nous remarquerons qu'une ligne violette  ou verticale ou horizontale 
paraîtra, selon le déplacement que nous accomplissons.

Si l'on presse le bouton gauche de la souris la ligne deviendra jaune et on peut la déplacer 
à l'endroit où nous voulons  diviser, puis bien sûr, vous devez confirmer le choix (bouton 
gauche de la souris).

Si on selectionne deux sommets, (touche Shift pressé et touche droite du mouse pour  
choisir les sommets), et on sélectionne Subdivide il sera appliqué un sommet seul entre 
les deux choisis.
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Extruder

Une des choses que plus  vous ferez sera d'extruder les différentes parties d'un objet.
Voyons  comment  faire.  Premièrement  retournont  a  notre  plan  de  base.  Puis  nous 
selectionnont deux sommets consecutifs.

Une fois fait ceci, appuyez sur la touche E et déplacez la souris. 
Maintenant, nous avons extrudé la partie sélectionnée.  Pour extruder exactement après 
avoir appuyé sur le bouton E il faut écrire les diverses combinaisons  vues précédemment 
pour déplacer les objets. Par exemple, pour extruder verticalement il faut appuyer  E, puis 
G>Z  se déplace.
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Changer de couleur et en attribuer une à chaque face

Maintenant vous ouvrez un nouveau travail, vous 
insérez un plan et divisez-le deux fois, puis vous 
revenez en Object mode. Jetez un coup d'oeil au 
menu Material.

D'abord assigner un matériau à tout l' objet 
en cliquant sur le bouton New.  Le plan est 
devenu gris.
En  faisant  click  dans  le  carré  gris  au 
dessous de  Diffuse  il  s'ouvrira  une fenêtre 
de laquelle pourrez changer couleur.

Pour assigner une couleur à chaque fasse nous devons entrer en modalité  Edit Mode, 
(Touche Tab),  et  sélectionner le bouton  Face Select Mode qui  permet de visualiser et 
sélectionner les faces d'un objet.
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Vous cliquez sur le + pour créer un nouveau matériel

Le programme crée une copie du précédent  matériel.  Pour differenzier la seconde du 
premier cliquez sur + qui se trouve près du nom.

Maintenant le nom changera en Material.001.

Changez la couleur et voici ce que vous verrez. Maintenant vous avez deux matériels de 
couleur différente.

Vous sélectionnez une figure.

En faisant click sur Assign vous assignerez le matériel à la figure sélectionnée.

Voilà comme apparaît  maintenant le plan. En continuant vous pouvez le colorer d'une 
couleur pour chaque figure.
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Créer des groupes de sommets

Dans le menu Object Date nous trouvons la fonction Vertex Groups, qui permet de créer 
des  groupes  de  sommets,  une  chose  vraiment  très  utile  quand  nous  créons  des 
illustrations complexes.

Faites  click  sur  le  bouton  New.  La  voix  Group  apparaîtra.  Changeons-la  en 
premiergroupe.

Maintenant  dans  Edit  Mode  et  avec  la  visualisation 
pour sommets vous sélectionniez ceux que vous voulez faire appartenir au groupe.
Une fois sélectionnés les sommets il suffit de faire click sur Assign pour créer le groupe.
Maintenant si vous essayez de cliquer sur Deselect et puis sur Select vous verrez que les 
sommets choisis seront sélectionnés et deselectionnés.
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UV Mapping

Elargissez la fenêtre sous-jacent la vue 3D.  Sélectionnez du menu la 
voix UV/Image Editor.

Maintenant, sélectionnez la face du cube que vous souhaitez mapper.
Appuyez sur la touche U, vous verrez un menu à partir duquel vous pouvez sélectionner 
Unwrap. Maintenant dans l'écran de UV la projection de la figure sélectionnée apparaîtra. 

Dans la barre de navigation ci-dessous cliquez sur Image puis sur  Open 
Ceci ouvrira la fenêtre pour rechercher le fichier à télécharger. Transférez une image.
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Une fois chargée l'image retournez en Object Mode et du menu  Draw Type sélectionnez 
la voix .Vous pourrez ainsi voir le résultat directement de la blindée de travail.
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Render

Ouvrez un nouveau travail et pressez F12. Voilà votre premier render. 

Essayons de modifier quelques voix du matériel et du monde pour voir les effets avec le 
render. Voyons comment faire. Nous entrons dans les propriétés du monde. Dans le sous-
menu  World trouvez  la  voix  Horizon Color, cliquez  sur  le  compartiment  gris  et  vous 
changez la couleur en bleu.  Dans le blindé Preview vous pourrez voir l'avant-première.

Maintenant essayez d'exécuter de nouveau le  Render (F12). Le fond sera de la couleur 
sélectionnée. Mais maintenant nous voulons que notre ciel soit nuancé. Pour le faire setter 
les paramètres comme ci-dessous:
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Voilà  maintenant  comment  est  l'avant-première du ciel.  Essayer  de faire  le Render et 
regardez le résulté final.

Maintenant nous pouvons nous concentrer sur les objets. Vous appliquez un étage sous le 
cube, comme si ce fût le plancher sur lequel appuie l'objet. Vous escaladez l'étage. Pour 
l'attacher au cube allé dans la vue frontale ou latérale, pour le déplacer verticalment aidez 
vous avec le bouton  CTRL, de  cette manière il se collera à la partie inférieure du cube.

Ajoutez un matériel à l'étage du menu Material en sélectionnant la voix New et attribuez 
un beau vert. Voici le render:
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Sélectionnez  le  cube  et  allez  dans  le  menu  Material.  Maintenant,  entrez  la  section 
Transparency et  fixez comme suit. Vous pourrez voir à côté   comment  viendra  l'avant-
première.

Faites de nouveau le Render.  Le cube est transparent.

Déplacez un peu le cube le long de l'axe y pour l'avoir en vue de la caméra un peu plus à 
droite.  Maintenant, ajoutez un plan à l'étage supérieur du plancher et del pavimento e 
tournez-le de 90 degrés. Vous devriez obtenir un résultat comme celui-ci.
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Il est arrivé le moment de faire devenir le nouvel étage un miroir. Pour premiere chose 
allez dans le menu Material, l'étage n'a pas encore de matériel assigné, faites le. Voici les 
paramètres pour le rendre  un miroir.

Si maintenant vous faites le Render voici ce que vous obtenez:

Une des fonctions les plus importantes du Render est l'Ambient Occlusion. Cette fonction 
a  été  étudiée  exprès  pour  les  programmes  de 
graphique 3d. Pour premiere chose nous enlevons 
la  lumière  à  notre  lampe.  Pour  faire  ceci 
sélectionnez la et allez dans le menu Object  data. 
Pour enlever énergie à la lampe nous mettons à 
zéro la voix Energy.   
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Si maintenant vous exécutez le render l'image  sera, à part  le ciel, toute noire.

Maintenant nous irons essayer l'ambient occlusion. Vous allez dans le menu World et vous 
sélectionnez la voix Ambient Occlusion. 

Exécutez le render. L'image sera beaucoup plus réel que la normale lampe mais si vous 
avez remarqué l'image n'est pas bien définie .... nous allons voir comment l'améliorer.

Si  vous  jetez  un'  coup  d'oeil  sous  l'inscription  Ambient  Occlusion vous  trouverez 
l'inscription  Samples. Sa valeur va de 1 a 32. Plus vous l'augmentez  plus le render  sera 
parfait,  pour contre vous aurez des temps plus longs. Si  vous n'avez pas de PC très 
puissant  n'utilisez pas de valeurs trop hautes. 

Render avec Samples a 5.
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Samples 10.

Samples 15.
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